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SECTION 1: General

1.1 NMCMPS RELATIONSHIPS

The Dynamic Reporting Tool (DRT) is fully integrated with the existing operational
Navy-Marine Corps Mobilization Processing System (NMCMPS). As such, the DRT
operates within BUPERS Online (BOL) and the Navy Marine-Corps Intranet (NMCI) as
a web-based application. The DRT utilizes the existing user administration and BOL
security integration currently implemented with the NMCMPS application.

1.2 DYNAMIC REPORTING TOOL OVERVIEW

The NMCMPS DRT enables users to design reports that query the NMCMPS database.
Once a report is designed, users can select from a number of outputs, including user-
friendly outputs (such as HTML, Excel, etc.) or raw data formats that can be used in
other data analysis systems.

Advanced Users should access the DRT Report Manager through the NMCMPS Site
Map. Depending on the advanced user’s technical background, they can select to create
reports from either one of the following Report Editors:

e The Report Builder: This nontechnical interface allows users to create and print
custom reports that pertain to the information in the selected module.

e The Report Designer: This technical interface allows users to specify report
properties, select data sets, modify the report layouts, chart or graph report
information, review XML statements, and preview or print reports.

Standard Users can access the DRT Ad-Hoc through certain NMCMPS search pages.
The DRT Ad-Hoc is a subset of the Report Builder. When opened, the Fields tab is
automatically populated with the module specific Ad-Hoc table. In addition, the DRT
Ad-Hoc will automatically create conditions used for filtering the data based on the
criteria entered into the fields on the module Search pages.

Please refer to the DRT Report Manager section and the DRT Ad-Hoc section for more
information.

1.3 REFERENCES

For further information, please refer to:
e NMCMPS Overview and Common Features User Manual
e Appendix A: .NET Formatting Standards
e Appendix B: Dynamic Reporting Tool Flow
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SECTION 2: The DRT Report Manager

2.1 ACCESSING THE DRT REPORT MANAGER

To access the Dynamic Reporting Tool Report Manager, navigate to BUPERS Online
URL. After logging in, select NMCMPS from the BOL Application menu.

For information on accessing BOL, please refer to Accessing NMCMPS in the NMCMPS
Overview and Common Features.

For information on the NMCMPS Site Map and Navigational Map, please refer to
NMCMPS Overview and Common Features.

To enter the DRT, click on the Site Map and select DRT (Dynamic Reporting Tool). The
DRT Report Manager page displays as shown in the following figure.

Figure 1: DRT Report Manager Page

Report Manager - 2.5.3.3 7
{=|Report = |=:|Preview = LE]Print ~+ Report Designer ¥
AMM OWM PM RTM 5M
Category = Namg Description
= Category: Demo (4 Items)
Demo Test 1 This iz a test
Demo TestZ This iz a test
Demo Members Due in by MRS Members Due in by MRA
Demo JessicaTest Test for Ad-HOc
Note:

To access Online Help, click the Help icon '* in the top right corner of the screens
within the DRT.

NMCMPS 2 UNCLASSIFIED
2010.12.15



2.2 THE DRT REPORT MANAGER FUNCTIONAL OVERVIEW

The DRT Report Manager page is the Home Page of the Dynamic Reporting Tool. From
this page, you can enter into one of two editors: The Report Builder or The Report
Designer.

Tabs across the DRT Report Manager Page represent the various NMCMPS modules.
Module specific reports display in grids under each corresponding tab.

2.3 DRT REPORT MANAGER MENU OPTIONS

Once you have entered the DRT Report Manager, menu options are available from the
tool bar at the top of the page.

Figure 2: DRT Report Manager Menu Options

] - Repaort = | =|Preview - LE{]Print + | Report Designer bt

The following table displays the options accessible from the Main Menu.

Table I: Main Menu Options
Hyperlink Description
Report Allows access to reporting options including creating a New
report or Opening, Deleting, Previewing or Printing an existing
report.
Preview Provides a preview of the selected report in its default output

format. Click the down arrow for a list of other available
preview outputs. Options include: Comma Separated Value
(CSV), Excel Worksheet (XLS), Fixed Text (TXT), Hyper-Text
Markup (HTML), eXtensible Markup (XML), Chart/Graph
(HTML)

Print Prints the selected report in its default output format. Click the
down arrow for a list of other available print outputs. Options
include: Comma Separated Value (CSV), Excel Worksheet
(XLS), Fixed Text (TXT), Hyper-Text Markup (HTML),
eXtensible Markup (XML), Chart/Graph (HTML)

Drop-Down Field Allows users to switch between the Report Designer and
Report Builder editors.

2.4 OPENING REPORTS

The DRT Report Manager lists all reports that have been created and saved in the Report
Designer, Report Builder and DRT Ad-Hoc.

To Open a Report:

a. Select the appropriate editor from the drop-down list. Note: Reports created in
the Report Builder or DRT Ad-Hoc are available through both editors. However,
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Reports created in the Report Designer are only available through the Report
Designer page.

b. Select the appropriate module tab on the DRT Report Manager page.

c. Select the report from the displayed grid by double-clicking in the row that
displays the report name.

OR

Select the report from the displayed grid by single-clicking the Report Name
hyperlink.

OR
Select the report from the displayed grid by highlighting the row that displays the

report name. From the menu bar, click the Report drop-down arrow and then
select Open.

Note:

Saved reports are accessible via the DRT Report Manager, which is accessed via the
DRT link on the NMCMPS Site Map. To access a saved report from either the Report
Builder or Report Designer, navigate to the Report tab and select the Report from the
drop-down list.

2.5 PREVIEWING REPORTS

When a report is previewed, only the first 500 lines of data in the report will be
displayed. The report will be displayed in the default output selected in the Report
Designer. Users can override the default output by clicking the down arrow next to the
Preview button.

Figure 3: Preview Options Menu

[ | Preview - @Print * Report Desigr

Q Comma Separated Value (C5V)
@ Excel Waorksheet (XLS)

EI Fixed Text (TXT)

[ Hyper-Text Markup (HTML)
@ eXtensible Markup (XML)

illl; Chart/Graph (HTML)
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To Preview a Report:
a. Select the appropriate module tab on the DRT Report Manager page.

b. Select the report from the displayed grid by single-clicking in the row that
displays the report name.

c. To preview the report in the default output, click the Preview button from within
the main toolbar. The report will display on the Report Preview window.

OR
To customize the output, click the down arrow next to the Preview button in the

toolbar. Select your output from the displayed list. The report will display in the
selected output on the Report Preview window.

Figure 4: Report Preview Window
Report Previewer - Members Due In By NRA =%
#%% For Official Use Only *#**
LLRD MCHL 5171008 | 00022 | 1011872007 | 32534 | 1011012007 | 00022 ?c: BUPERS
N ! : 22 2007 3233 2 2212803y INGTON T
0001
GRN JHN 3112001 | 00022 | 10502007 | 32424 | 1112007 | 09326 \;,F BUPERS
STRNG B R nal e = o001 |MILLINGTON T
gggg.c 5 | 10711999 | 00061 43322 COMUSNAVEU
KR MCHL 00061 00061 COMUSNAVEU
E?\EDGLS 511999 | 00061 | 97162003 |3254A | 91672003 | 00080 COMUSNAVEU
E}T{EYL . 7| 71111907 | 00061 43339 COMUSNAVEU
RYS NE-
CHRSTPHR 211997 | 00061 | 77152003 |32494 | 712003 | 49167 | 0689- | comusNavEY
NL 0093
LTTFN s s e NE- et
STPHN JHN 5| 1011999 | 00061 | 71272003 | 32494 | 67282003 | 00061 | 0686- | COMUSNAVEU
NIHD 0006 -
L]
L Cosé

d. To close this window, click the Close button.

2.6 PRINTING (GENERATING) REPORTS

When a report is printed, the entire data set will be returned in the format selected in the
Report Designer. Users can override the default output by clicking the down arrow next
to the print button in the toolbar.
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Figure 5: Print Options Menu

]— Report - _IPFE'u'iE'i'I.' - uE{]P'rint ~| Report Designer »

AMM WM FM A Q Comma Separated Value (C5V)
@ Excel Worksheet (XLS)

EI Fixed Text (TXT)

[ Hyper-Text Markup (HTML)
@ eXtensible Markup (XML}

illl; Chart/Graph (HTML)

Category = Namg

® Category: Demo (5 Iten

To Print (or Generate) a Report:
a. Select the appropriate module tab on the DRT Report Manager page.

b. Select the report from the displayed grid by clicking in the row that displays the
report name.

c. To print the report in the default output, click the Print button from within the
main toolbar. The Report Previewer window will open displaying the report in
the default output.

OR
To customize the output, click the down arrow next to the Print button in the
toolbar. Select your output from the displayed list. The Report Previewer

window will open displaying the report in the selected output.

d. If youwould like to print a paper copy of the report, right click the Report
Previewer window and select the Print option.

Note:
The CSV output will need to be saved to your computer and will not appear in the

Report Previewer window.

2.7 USING THE GRID
2.7.1 Grid Overview

Each tab within the DRT Report Manager displays a grid of available reports. To display
a record, click the available hyperlink in the row or double click on any part of the row.
You can customize the look of the grid by rearranging the columns, grouping data,
sorting by any column or selecting the columns you would like to see displayed.
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2.7.2 Sorting the Grid

You can sort data from within the grid by any column heading in either ascending or
descending order. Click the column heading once and a small blue up arrow appears to
the right of the column heading. The grid is sorted in ascending or chronological order by
that field. Click the column heading a second time and a small blue down arrow appears
to the right of the column heading. The grid is sorted in descending or reverse
chronological order by that field.

By placing your mouse over a column heading or by single clicking a column heading, a
small black arrow becomes available. By selecting the black arrow, a secondary menu
will become available, as shown in the following figure.

Figure 6: Column Secondary Menu

‘fz_“ l Sort Ascending

il Sort Descending
4 Columns %

=| Group By This Field

7| Show in Groups

2.7.3 Grouping and Ungrouping Displayed Data

You can group data on the grid by one of the grid columns, enabling you to organize all
requirements by a particular field. For example, in the DRT Report Manager, you can
group information by the Category or Name of the report. The following figure shows
reports grouped by Category.
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Figure 7:
Report Manager
]— Report = | 5|Preview » E{]Print = Report Designer
AMM OwWM FM RTM 5M
Category = Name
# Category: General (1 Item)
# Category: One (3 Items)

[ Category: Three (2 Items)

Grid Grouped by Category

Description

In the above example, each different Category displays once on the list. The number in
parentheses to the right of the Category name displays the number of items associated
with each Category. You can view the reports associated with a particular row by
clicking on the plus icon # to the left of the column. The following figure shows the grid

grouped by Category with the report names under that group displayed.

NMCMPS
2010.12.15
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Figure 8: Grid Listing Reports within a Category

Report Manager ?
gi Report = ‘_'|Preview - [E]Print = Report Designer L

AMM oM M RTM SM

Category = Name Description

[ Category: General (1 Item)
# Category: One (3 Items)

= Category: Three (2 Items)

Three Notification Peried Report
Three Notification Peried Report Average D...

To Group Displayed Data:

a. Single click or place your mouse over the column header you want to use to
group your search results.

b. Click on the black arrow to view the Column Secondary menu.

C. Select the Group by this Field option. The figure below shows how to
execute this feature.
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Figure 9: Grid with Column Secondary Menu Displayed

Name = ¥ Description
A .
ue In By NRA (1 Ttem) 4| Sort Ascending

il Sort Descending

[EH Columns B

=| Group By This Field
Shaow in Groups

The data is then grouped by the selected column heading.
d. To display the contents of the group, click the plus icon.
To Ungroup Columns:

a. To show each record individually, single click or place your mouse over any
column heading.

b. Click on the black arrow to view the Column Secondary menu.

c. Uncheck the “Show in Groups” option from the menu. The grid returns to list
each record individually.

2.7.4 Adding and Removing Columns

In order to customize the grid according to your preferences, you can add or remove
columns.

To Add a Column:
a. Single click or place your mouse over any column heading.

b. Click on the black arrow to view the Column Secondary menu.

Figure 10:  Column Secondary Menu

‘% l Sort Ascending
il Sort Descending
=h| Columns %
Col

=| Group By This Field
Show in Groups
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Click on the Columns menu option and a list of available columns displays.
Each column currently appearing in your grid is marked with a check mark.
Other available columns are listed without a check mark.

Click on an unchecked column name corresponding to a column you want to
add to your grid so that a checkmark appears.

To Remove a Column:

Single click or place your mouse over any column heading.

Click on the black arrow to view the Column Secondary menu.

Click on the Columns menu option and a list of available columns displays.
Each column currently appearing in your grid is marked with a check mark.

Other available columns are listed without a check mark.

Click on the column name corresponding to a column you want to remove on
your grid so that the column name is unchecked.

2.8 CREATING A NEW REPORT

To Create a Report:

a.

On the DRT Report Manager page, select the tab corresponding to the module in
which you would like to build your report.

Single click the Report button from within the main toolbar or click the Report
drop-down arrow and then select New.

Depending on which Editor has been selected on the DRT Report Manager page,
either the Report Builder or Report Designer window will appear.

Starting with the first displayed tab, fill out appropriate information on the tab.
Working from left to right, repeat on each tab. (Refer to sections on The Report
Builder and The Report Designer for more information on each tab.)

Click the Save button at the bottom of the screen.

2.9 EDITING OR MODIFYING A REPORT

To Edit or Modify a Report:

a. Onthe DRT Report Manager page, select the tab corresponding to the module

that contains the report you would like to edit or modify.
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b. Click on the report name hyperlink or double click on the row that contains the
report information that you would like to edit or modify.

c. Depending on which Editor has been selected, the Report Builder or Report
Designer window will appear.

d. Starting with the first displayed tab, edit the appropriate information in the tab.
Working from left to right, repeat on each tab. (Refer to The Report Builder and
The Report Designer sections for more information on each tab.)

e. Click the Save button at the bottom of the screen.

OR
To save the changes under a different name, click the Save As button at the

bottom of the screen. Note: In order to use the Save As function, users must
change both the Name and Caption fields on the Report Tab.
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SECTION 3: The Report Builder

3.1 THE REPORT BUILDER FUNCTIONAL OVERVIEW

The Report Builder is available from within the DRT Report Manager and is the user
interface for nontechnical users. This Editor allows users to create and print custom
reports that pertain to the information in the selected module.

To access the report builder, make sure that Report Builder is selected on the DRT
Report Manager Page as shown below.

Figure 11:  DRT Report Manager Page with Report Builder Selected

Report Manager - 2.5.3.3 7
{=|Report = |=:|Preview = LE]Print ~+ Report Builder ¥

AMM OWM PM RTM 5M

Category = Namg Description

Once the Report Builder is selected in the DRT Report Manager, opening an existing
report or creating a new report will give you access to the Report Builder.
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Figure 12:  Report Builder Page

Report Builder - OWM March 2010 a7
Filter Fields Sort Sort Direction Summary Format Position Report Preview
Prefoc Table Field Operator Value Suffec  Conjunction
Ad-Hoc EngineType Equal To c
Ad-Hoc SSN Equal To e |
Ad-Hoc UICType Equal To 0
[ test |[ save || saveas [ preview ][ Pt ][ close

The Report Builder consists of nine tabs, which can be accessed in any order. However,
when building a new report, start with the Filter tab (read-only) and work across the
screen from left to right, ending with the Preview tab.

When you initially select a tab, you will see the tab contents in view mode. Once you
make changes or edit information, you will need to Save the changes before closing out
of the Report Builder.

3.2 REPORT BUILDER COMMAND BUTTONS

The Report Builder offers command buttons at the bottom of each page.
Figure 13:  Report Builder Command Buttons

[ Test ] [ Save ] [ Save As ] [ Prewview '] [ Print '] [ Close

The following table displays the available buttons options.
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Table Il

Report Builder Command Buttons

Hyperlink

Description

Test

Displays a message about the number of records in the data
set and size of the opened report.

Save

Saves the report that has been built. Note: A report will not
save unless all required information is entered into the Report
tab.

Save As

Saves a copy of the selected report under a different name.
Note: In order to use the Save As function, users must
change both the Name and Caption fields on the Report Tab.

Preview

Provides a preview of the selected report. Click the down
arrow for a list of available preview outputs. Options include:
Comma Separated Value (CSV), Excel Worksheet (XLS),
Fixed Text (TXT), Hyper-Text Markup (HTML), eXtensible
Markup (XML), Chart/Graph (HTML) Note: CSV and XLS
outputs will not be previewed on this screen and will require a
file download.

Print

Prints the selected report. Click the down arrow for a list of
available print outputs. Options include: Comma Separated
Value (CSV), Excel Worksheet (XLS), Fixed Text (TXT),
Hyper-Text Markup (HTML), eXtensible Markup (XML),
Chart/Graph (HTML).

Close

Closes the Report Builder screen.

3.3 THEFILTER TAB (REPORT BUILDER)

The Filter Tab displays the conditions used to filter the data set used in the report. This
tab displays read-only information based on information generated from the DRT Ad-

Hoc.
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Figure 14:

Report Builder - Filter Tab
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3.4 THE FIELDS TAB (REPORT BUILDER)

The Fields Tab allows users to specify the fields that will be available for inclusion in the
report output. To specify a set of fields for the report, the user must first select a table
from the Table pick list. Available tables are populated based on the Ad-Hoc reporting

specifications and module. The following image displays the Fields Tab.
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Figure 15:  Report Builder - Fields Tab
Report Builder - Demo of the Report Builder -ll?|x
Filter Fields Sort Sort Direction Summary Format Position Report Preview
Table £
Table: | Select a table ¥
Available Actions Selected
Field « Field
Fullhame Top
SSN
Ai_poc
ApprovedDemobDate
06
BOGEndDate
BOGLocation
COMP
Test ] [ Save ] [ Save As ] [ Preview ™ ] I Print = ] [ Close

To Select Fields:

a. Select a Table from the drop-down list. Available fields for the selected table
will appear.

b. From the Available list, select the fields(s) you want to include in your report
by clicking on the checkbox next to the table name. Once selected, a
checkmark will appear in the box.

c. Click the right arrow (->) button to move the field (or fields) from the
Available list to the Selected list. Repeat this step as necessary until all
desired fields appear on the Selected list.
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Figure 16:  Report Builder - Selected Fields

Report Builder - Demo of the Report Builder -ll?|x
Filter Fields Sort Sort Direction Summary Format Position Report Preview
Table £
Table: | Select a table
Available Selected
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BOG SSN
BOGEndDate AMM_POC
BOGLocation
COMP 22

A
A

S| |8
I A A A

Down

Bottom

[ Test ] [ Save ] [ Save As ] [ Preview Y] [ Print Y] [ Close ]

d. To add fields from a different table, change the selected Table. Repeat the
last two steps until all desired fields appear in the Selected list.

e. When you finish selecting the fields, you can change the order of the list by
clicking on a field name and clicking the Up or Down buttons. After
selecting a field name, you can move it to the top or bottom of the list by
clicking the Top or Bottom buttons.

f. (Optional) Click the Save button to save your work on the report.

3.5 THE SORT TAB (REPORT BUILDER)

The Sort Tab allows users to specify the fields that will be used to sort the data included
in the report output. To specify a set of sorting fields for the report, the user will move
the desired fields from the Available column to the Selected column. The resulting data
for the report will be sorted using the fields in the order that they appear in the Selected
Column.
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Figure 17:  Report Builder - Sort Tab

Report Builder - Demo of the Report Builder -ll?|x
Filter Fields Sort Sort Direction Summary Format Position Repart Preview
Available Actions Selected
Field Field
SSN FullMame
AMNM_POC
ApprovedDemobDate
BOG Loz
BOGEndDate
BOGLocation
COMP

[ Test ] [ Save ] [ Save As ] [ Preview Y] [ Print Y] [ Close

To Select the Sort Order of Fields:

a. ldentify field(s) from the Available list that you would like the data sorted by on
your report. Select the field(s) by clicking on the checkbox next to the field
name. Once selected, a checkmark will appear in the box.

b. Click the right arrow (->) button to move the field (or fields) from the Available
list to the Selected list. Repeat this step as necessary until all desired fields appear
on the Selected list.

c. The report will be sorted using the fields in the order that they appear in the
Selected list. Change the order of this list by clicking on a field name and
clicking the Up or Down buttons. After selecting a field name, you can move it
to the top or bottom of the list by clicking the Top or Bottom buttons.

d. (Optional) Click the Save button to save your work on the report.
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3.6 THE SORT DIRECTION TAB (REPORT BUILDER)

The Sort Direction Tab allows users to specify the direction (ascending or descending)
that data will be displayed for specific fields in the report output. To specify a sort
direction, the user will select the desired fields from the Fields list and then specify the
direction of the sort.

Figure 18:  Report Builder - Sort Tab

Report Builder - Demo of the Report Builder DB
Filter Fields Sort Sort Direction Summary Format Position Repaort Preview
Sort Direction *
Field: Sort Direction: | Ascending v
Modify Direction In List
Figld Direction
FullName: A
[ Test ] [ Save ] [ Save As ] [ Preview ™ ] [ Print .S ] [ Close

To Specify the Sort Direction of a Field:

a. Select a Field from the table by clicking the row within the table. Information on
the selected field will display on the top portion of the screen.

b. Select a Sort Direction from the drop-down list.

c. Click the Modify Direction in List button. The table will reflect the updated
information.

Note:

By selecting multiple rows, users can modify more than one field at a time. Only the first
row selected will appear in the top portion of the screen. However, all selected rows will
be modified in the table.
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d. Repeat steps a-c as necessary.

e. (Optional) Click the Save button to save your work on the report.

3.7 THE SUMMARY TAB (REPORT BUILDER)

The Summary Tab allows users to specify the fields that will be used to summarize the
data included in the report output. To specify a set of summary fields for the report, the
user will move the desired fields from the Available Column to the Selected Column.
The resulting data for the report will display the Sum of numeric fields and the Count of
non-numeric fields in the order that the fields appear in the Selected Column.

Figure 19:  Report Builder - Summary Tab

Report Builder - Demo of the Report Builder alle |

Filter Fields Sart Sart Direction Summary Farmat Position Repaort Preview

Available Actions Selected
Field Field
FullName COMP
S5N
AMM_POC
ApprovedDemobDate Lop
BOG
BOGEndDate
BOGLocation

Test ] [ Save ] [ Save As ] [ Preview Y] [ Print Y] [ Cloge

To Summarize Fields:

a. ldentify field(s) from the Available list that you would like to use to summarize
the data on your report. Select the field(s) by clicking on the checkbox next to the
field name. Once selected, a checkmark will appear in the box.

NMCMPS 21 UNCLASSIFIED
2010.12.15



b. Click the right arrow (->) button to move the field (or fields) from the Available
list to the Selected list. Repeat this step as necessary until all desired fields appear
on the Selected list.

c. The report will be summarized using the fields in the order that they appear in the
Selected list. Change the order of this list by clicking on a field name and
clicking the Up or Down buttons. After selecting a field name, you can move it
to the top or bottom of the list by clicking the Top or Bottom buttons.

d. (Optional) Click the Save button to save your work on the report.

3.8 THE FORMAT TAB (REPORT BUILDER)

The Format Tab is an optional feature that allows users to specify the width and format of
the fields or columns that will appear in the report. Users can choose to specify the
width, the format or both the width and format of the columns.

Figure 20:  Report Builder - Format Tab

Report Builder - Demo of the Report Builder |2 ]
Filter Fields Sort Sort Direction Summary Format Position Repart Preview
Format S
Field: Width: Format:
Modify Format In List
Field Width Format
FullName 0
SSN 0
AMM_POC 0
ApprovedDemobDate 0
BOG 0
BOGEndDate 0
BOGLocation 0
COMP 0
Test ] [ Save ] [ Save As ] [ Preview ¥ ] [ Print = ] [ Close
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To Modify a Field’s Format:

a.

Select a Field from the table by clicking the row within the table. Information on
the selected field will display on the top portion of the screen.

Type in the desired column Width (in number of characters). Note: The entered
value must be less than the default field width; entering a value greater than or
equal to the default field width will not change your report.

Type the Format for the field. Note: This field must conform to what the
String.Format() method expects in the .NET framework. Please refer to Appendix
A.

Click the Modify Format to List button. The table will reflect the updated
information.

Repeat steps a-d as necessary. Note: If the Width value remains zero, the report
will display all data for the specified field.

(Optional) Click the Save button to save your work on the report.

3.9 THE POSITION TAB (REPORT BUILDER)

The Position Tab is an optional feature that allows users to specify the order that fields
will appear in the report. If nothing is specified on this tab, the fields in the report will
appear in the same order as they originally appear in the list.
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Figure 21:  Report Builder - Position Tab

Report Builder - Demo of the Report Builder -ll?]x

Filter Fields Sort Sort Direction Summary Format Position Repart Preview

Name Position

FullMame 2

SSN 1

AMNM_POC 3

ApprovedDemobDate 5

BOG 4

BOGEndDate 6

BOGLocation 7

COMP 8

[ Test ] [ Save ] [ Save As ] [ Preview "] [ Print '] [ Close

To Position Fields in a Report:

a. Click in the row of the first field that you would like to appear in your report. The
Position value will change from “0” to “1”, indicating that this field will appear
first in your report.

b. Click the row of the second field that you would like to appear in your report.
The Position value will change from “0” to “2”.

C. Repeat as necessary or until all Position values are changed from “0”. Note: Ifa
Position value remains as “0”, it will appear before all other values. If multiple
Position values remain as “0”, they will appear before all other values in the order
they are listed in the table.

d. (Optional) Click the Save button to save your work on the report.

Note:
To remove a Position value from a row or to return the value to “0”, click in the row for a
second time.
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For best results, Positions should be removed in reverse order. For example, if your list
is numbered 1-10 and you need to renumber item number 6, start with changing the “10”
value to “0” and proceed backwards until you reach item number “6”.

3.10 THE REPORT TAB (REPORT BUILDER)

The Report tab contains general information about the report including the report Name,
default output, owner, category, etc. With the exception of the Description field, all
values on this tab are required. The following image displays the report tab for a new
report.

Figure 22:  Report Builder - Report Tab

Report Builder - Demo of the Report Builder -7 |x
Filter Fields Sort Sort Direction Summary Format Position Report Preview
Report: | Dema of the Report Builder b4

Mame: ReportBuiderDemo
Caption: | Demo of the Report Builder
Description: | This reports demonstrates the Report Buider.

Owner: | Mark Lincoln "

Module: | AMM v

Category: |General M

Format: | XML v

Display: | For Everyone ~

Update: | For Me Only o
[ Test ] [ Save ] [ Save As ][ Preview Y][ Print Y] [ Close

To Complete the Report Tab:

a. If you would like to modify an existing report, select the report name from
Report field. If you would like to create a brand new report, leave the Report
field blank.

b. Type a Name for the report. This will be used to later identify the report in the
system. Note: This field should not contain any spaces or special characters.
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c. Type a Caption for the report. This will be displayed to the user in the available
reports list.

d. If desired, fill in a Description of the report.
e. Select values for the Owner of the report. Typically, this will be the current user.

f. Select the Module in which you will be pulling your information. Note: After
created, your report will show up under the Module tab you selected.

g. Selecta Category for the report, which will be used to organize the report into
logical groups.

h. Select the default Format for printing. Note: After created, you can always
select to print in an alternate format.

i. Select whether you would like this to be a public or private report upon initial
Display and Updates thereafter.

j. (Optional) Click the Save button to save your work on the report.

3.11 THE PREVIEW TAB (REPORT BUILDER)

The Preview tab is used to preview the data and layout format of the designed report.
When reports are previewed, only the first 500 records appear on the report. When
selected, the Preview tab displays the report in the default output.
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Figure 23:

Report Builder - Preview Tab
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When viewing reports through the Preview tab, clicking the Close button will close the
Report Builder and will not save any changes.

Note:

To preview the report in a different output, click arrow next to the Preview button at the
bottom of the window. Select the desired output from the displayed list. A secondary
window will display a preview of the report. Click the Close button on the Report
Preview Window to close the secondary screen and return to the Report Builder.
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SECTION 4: The Report Designer

4.1 REPORT DESIGNER FUNCTIONAL OVERVIEW

The Report Designer allows you to create a new report or modify an existing report.
Accordingly, six tabs across the top of the screen allow the user to:

e edit the report properties

e edit the data sets for the report
modify the layout for the rendering of the report to its output destination
chart or graph the report information
review the XML statement created by the Report Designer
preview the report output

The Report Designer is the user interface for technical users. This Editor allows users to
create and print custom reports that pertain to the information in that module.

To access the Report Designer, make sure that Report Designer is selected on the DRT
Report Manager Page as shown below.

Figure 24:  DRT Report Manager Page with Report Designer Selected

Report Manager ?
] =|Report = | :|Preview « LE:]Print = Report Designer b
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Once the Report Designer is selected in the DRT Report Manager, opening an existing
report or creating a new report will give you access to the Report Designer window.

Figure 25:  Report Designer Page

Report Designer - Members Due in by NRA all2]x
Report Data Layout Charting XML Preview
Report: |Members Due in by NRA 4
Name:  MembersDueinbyMNRA
Caption: | Members Due in by NRA
Description: | Members Due in by NRA

Owner: |Jim Fauntleroy A
Module: | AMM b
Category: Demo e
Format: | Hyper-Text Markup (HTML) =
Display: | For Everyane b4
Update: | For Everyone .

SQL Plug-In:

Render Plug-In:

[ Test ][ Save ][ Save As ][ Preview Y][ Print "H Close ]

The Report Designer screen consists of six main tabs, which can be accessed in any
order. However, when building a new report, start with the Report tab and work across
the screen from left to right, ending with the Preview tab.

When you initially select a tab, you will see the tab contents in view mode. Once you
make changes or edit information, you will need to Save the changes before closing out
of the Report Designer window.

4.2 REPORT DESIGNER COMMAND BUTTONS

The Report Designer offers command buttons at the bottom of each page.
Figure 26:  Report Designer Command Buttons

[ Test ] [ Save ] [ Save As ] [ Preview *] [ Print *] [ Close

The following table displays the available buttons options.
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Table I11: Report Designer Command Buttons

Hyperlink Description

Test Displays a message about the number of records in the data
set and size of the opened report.

Save Saves the report that has been built. Note: A report will not
save unless all required information is entered into the Report
tab.

Save As Saves a copy of the selected report under a different name.

Note: In order to use the Save As function, users must
change both the Name and Caption fields on the Report Tab.

Preview Provides a preview of the selected. Click the down arrow for
a list of available preview outputs. Options include: Comma
Separated Value (CSV), Excel Worksheet (XLS), Fixed Text
(TXT), Hyper-Text Markup (HTML), eXtensible Markup (XML),
Chart/Graph (HTML) Note: CSV and XLS outputs will not be
previewed on this screen and will require a file download.

Print Prints the selected report. Click the down arrow for a list of
available print outputs. Options include: Comma Separated
Value (CSV), Excel Worksheet (XLS), Fixed Text (TXT),
Hyper-Text Markup (HTML), eXtensible Markup (XML),
Chart/Graph (HTML)

Close Closes the Report Designer screen.

4.3 THE REPORT TAB (REPORT DESIGNER)

The Report tab contains general information about the report including the report Name,
default output, owner, category, etc. All values on this tab, except for the Description,
SQL Plug-In and Render Plug-In, are required. The following image displays the report
tab for an existing report.
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Figure 27:  Report Designer - Report Tab

Report Designer - Members Due in by NRA -7
Report Data Layout Charting XML Preview
Report: | Members Due in by NRA >
Name: | MembersDueinbyNRA
Caption: | Mermbers Due in by NRA
Description: | Members Due in by NRA

Owner: |Jim Fauntleroy —
Module: | AMM e
Category: | Demo Y
Format: | Hyper-Text Markup (HTML) N
Display: | For Everyone w7
Update: | For Everyone —
SQL Plug-In:

Render Plug-In:

[ Test ] [ Save ] [ Save As ] [ Preview Y] [ Print "] [ Close

To Complete the Report Tab:
a. If you would like to modify an existing report, select the report name from the
Report field. If you would like to create a brand new report, leave the Report
field blank.

b. Type a Name for the report which will be used by the system to identify the
report. Note: This field should not contain any spaces or special characters.

c. Type a Caption for the report. This will be displayed to the user in the available
reports list and the DRT Report Manager.

d. If desired, fill in a Description of the report.
e. Select values for the Owner of the report. Typically, this will be the current user.

f. Select the Module in which you will be pulling your information. Note: After
created, your report will show up under the Module tab you selected.
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g. Select a Category for the report, which will be used to organize the report into
logical groups.

h. Select the default Format for printing. Note: After created, you can always
select to print in an alternate format.

I. Select whether you would like this to be a public or private report upon initial
Display and Updates thereafter.

j. If additional processing to create SQL statement is required, type the name of a
.NET plug-in assembly into the SQL Plug-In field.

k. If additional processing during the rendering or printing of the report is desired,
type the name of a .NET plug-in assembly into the Render Plug-In field.

I. (Optional) Click the Save button to save your work on the report.

44 THE DATA TAB (REPORT DESIGNER)

The Data tab allows users to handle complex reporting by selecting more than one data
set from a pick list. The Data tab itself contains thirteen tabs for defining the data sets for
the report. Users will first select the tables for the report. Next, they will select data
fields, join tables, and create a data set filter condition. Finally, they will define groups,
sort the data, choose which fields should contain sums of information and format the
report.

The thirteen tabs within the Data Tab can be accessed in any order. However, when
building a new report, start with the Tables tab and work across the screen from left to
right, ending with the SQL tab

4.4.1 The Tables Tab (Report Designer)

The Tables Tab allows users to manage the data sets required for the report by selecting
the tables from a pick list. The following image displays the Tables Tab.
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Figure 28:  Report Designer - Tables Tab
Report Designer - Members Due in by NRA DB
Report Data Layout Charting XML Preview
Tables | Figlds Joins Filter Sort Sort Direction Group Group Filter Summary Format Expression Position SQL
Available Actions Selected

Table = []| Table
Auditlog o
14 Audit

m

l&MWLookup_CapGroups

IAMMLockup_HoldTypes al

(=]
=]

laMMLookup_|StopReasons
I&MMLookup_|StopStatus
l&MKMLookup_OrderTypes
laMMLookup_OrdersStatus
l&NMMLookup_Status
l&Member

W
W

l&Member_|Stops
ImplementOrders
Laokup_ActionOfficers

M
M

|

Lookup_aAirheads
Lookup_&ll_UICs
Leckup_All_UICs_Backup

Down

Lookup_Akernate_UICs
P - Bottom
Loockup_aAppointmentTypes

Lookup_&ugTypes

=

I IO EEOO00000DDDEEEEEET OO

Leokup_BilletCategory

Test ] ’ Save ] [ Save As ] [ Preview '] ’ Print '] ’ Close

To Select Tables:

a. From the Available list, select the table(s) you want to include in your report by
clicking on the checkbox next to the table name. Once selected, a checkmark will
appear in the box.

b. Click the right arrow (->) button to move the field (or fields) from the Available
list to the Selected list. Repeat this step as necessary until all desired fields appear
on the Selected list. To move all fields to the Selected list, click the double arrow
(->>) button.
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Figure 29:

Report Designer - Selected Tables
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[ Test ] [ Save ] [ Save As ] [ Preview "] [ Print Y] [ Close ]

c. When you finish selecting the tables, you can change the order of the list by
clicking on a table name and clicking the Up or Down buttons. After selecting a
table name, you can move it to the top or bottom of the list by clicking the Top or
Bottom buttons.

d. To remove a field (or fields) from the Selected list, highlight the field(s) you’d
like to move and click the left arrow (<-) button. To move all fields in the
Selected list, click the double left arrow (<<-) button.

e. (Optional) Click the Save button to save your work on the report.

Note:

Tables cannot be removed from the Tables Tab unless all of their corresponding fields are
also removed from the Fields Tab. If a Table is moved from the Selected list back to the
Available list but its corresponding fields are still Selected on the Fields tab, the report
will save as if the Table was still on the Available list.
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4.4.2 The Fields Tab (Report Designer)

The Fields Tab allows users to specify the fields that will be available for inclusion in the
report output. To specify a set of fields for the report, the user must first select a table
from the Table pick list (Refer to The Table Tab section). If the user has specified only
one table for the report in the Tables tab, that table will already be selected on the Fields
tab. The following image displays the Fields Tab.

Figure 30:  Report Designer - Fields Tab
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To Select Fields:

a. Selecta Table from the drop-down list. Available fields for the selected table
will appear.

b. From the Available list, select the fields(s) you want to include in your report
by clicking on the checkbox next to the table name. Once selected, a
checkmark will appear in the box.
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c. Click the right arrow (->) button to move the field (or fields) from the
Available list to the Selected list. Repeat this step as necessary until all
desired fields appear on the Selected list.

Figure 31:  Report Designer - Selected Fields

Report Designer - Members Due in by NRA a2
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d. To add fields from a different table, change the selected Table. Repeat the
last two steps until all desired fields appear in the Selected list.

e. When you finish selecting the fields, you can change the order of the list by
clicking on a field name and clicking the Up or Down buttons. After
selecting a field name, you can move it to the top or bottom of the list by
clicking the Top or Bottom buttons.

f. (Optional) Click the Save button to save your work on the report.
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Note:

Tables cannot be removed from the Tables Tab unless all of their corresponding fields are
also removed from the Fields Tab. If a Table is moved from the Selected list back to the
Available list but its corresponding fields are still Selected on the Fields tab, the report
will save as if the Table was still on the Available list.

4.4.3 The Joins Tab (Report Designer)

The Joins Tab allows users to specify the condition to join two or more tables in the data
set for use in the report. To create a joining condition, select a parent table, a child table,
and the fields that will link them together. Users can also specify whether null values
from the parent or child table should be included in the report data set.

Figure 32:  Report Designer - Joins Tab

Report Designer - Members Due in by NRA a2
Repart Data Layout Charting XML Preview
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To Join Tables:

a.

Select a Parent Table and corresponding Parent Field from the drop-down lists.
Click in the checkbox to Include Null VValues for this selection.

Select a Child Table and corresponding Child Field from the drop-down lists.
Click in the checkbox to Include Null VValues for this selection.

Click the Add Joined Tables to List button.

To Modify Joined Tables:

a.

Select the row in the grid that you would like to modify by either single clicking
in that row or placing a check in the checkbox for the corresponding row.

The data for the selected row will appear in the fields above the grid. Make
necessary changes to fields.

Click the Modify Joined Tables in List button. Your changes will be reflected
in the grid.

To Remove Joined Tables:

a.

444

Select the row(s) in the grid that you would like to remove by either single
clicking in that row or placing a check in the checkbox(s) for the corresponding
row(s).

Click the Remove Joined Tables from List button. The selected tables will be
removed from the grid.

The Filter Tab (Report Designer)

The Filter Tab allows users to specify the condition to filter the data set for use in the
report. The filter condition created is a Boolean expression used to limit that data
available in the data set for the report. In order to create the filter condition, the user
must assemble filter clauses that are in the form of Field Operator Value (i.e. Field =
100). Multiple filter clauses can be assembled to create a complex filter condition using
logical conjunctions (i.e. And and Or) and parenthesis for grouping the clauses into valid
Boolean expressions. To create a clause for the filter condition, the user will select a
Field, an Operator, and specify a Value. The Value for the clause can be a scalar value
specified by the user or a value selected from existing values for the field in the database.
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Figure 33:  Report Designer - Filter Tab
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Test ] [ Save ] [ Save As ] ’ Preview "] ’ Print '] [ Cloge

To Add a Filter Condition:
a. Selecta Table and Operator from the drop-down lists.
b. Type in the Value for the condition.
c. Select the appropriate Field for the condition.

d. If this condition will be associated with another, select a Conjunction from the
drop-down list.

e. To group conditions, use the Prefix and Suffix fields as necessary.

f. Click the Add Filter Condition to List button.

Note:
To test for a value being null, use the “Equal To” operator and $NULL as the field
value. The Report server will resolve this expression into a valid “is null” condition.
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To test for not null, use the “Not Equal To” operator and $NULL as the field value. The
Report server will resolve this expression into a valid “is not null” condition.

To test for null strings, use either “Equal To” or “Not Equal To” as the operator and the
SNULLSTRING or ¢ as the field value.

To Modify a Filter Condition:

a. Select the row in the grid that you would like to modify by either single clicking
in that row or placing a check in the checkbox for the corresponding row.

b. The data for the selected row will appear in the fields above the grid. Make
necessary changes to fields.

c. Click the Modify Filter Condition in List button. Your changes will be reflected
in the grid.

To Remove a Filter Condition:

a. Select the row(s) in the grid that you would like to remove by either single
clicking in that row or placing a check in the checkbox(s) for the
corresponding row(s).

b. Click the Remove Filter Condition from List button. The selected tables
will be removed from the grid.

4.45 The Sort Tab (Report Designer)

The Sort Tab allows users to specify the fields that will be used to sort the data included
in the report output. To specify a set of sorting fields for the report, the user will move
the desired fields from the Available Column to the Selected Column. The resulting data
for the report will be sorted using the fields in the order that they appear in the Selected
Column.

NMCMPS 40 UNCLASSIFIED
2010.12.15



Figure 34:  Report Designer - Sort Tab

Report Designer - Members Due in by NRA all2]x

Report Data Layout Charting XML Preview
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Available Actions Selected
Field Field
CLAIMANT
Description
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[ Test ] [ Save ] [ Save As ] [ Preview Y] [ Prinit Y] [ Close

To Select the Sort Order of Fields:

a. Identify field(s) from the Available list that you would like the data sorted by on
your report. Select the field(s) by clicking on the checkbox next to the field
name. Once selected, a checkmark will appear in the box.

b. Click the right arrow (->) button to move the field (or fields) from the Available
list to the Selected list. Repeat this step as necessary until all desired fields appear
on the Selected list.

c. The report will be sorted using the fields in the order that they appear in the
Selected list. Change the order of this list by clicking on a field name and
clicking the Up or Down buttons. After selecting a field name, you can move it
to the top or bottom of the list by clicking the Top or Bottom buttons.

d. (Optional) Click the Save button to save your work on the report.
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4.4.6 The Sort Direction Tab (Report Designer)

The Sort Direction Tab allows users to specify the direction (ascending or descending)
that data will be displayed for specific fields in the report output. To specify a sort
direction, the user will select the desired fields from the Fields list and then specify the
direction of the sort. Fields displayed here reflect the fields selected on the Sort tab.

Figure 35:  Report Designer - Sort Direction Tab

Report Designer - Members Due in by NRA a2l

Report Data Layout Charting XML Preview

Tables Fields Joins Filter Sort Sort Direction Group Group Filter Summary Format Expression Position 0L
Sort Direction ES
Field: | site Sort Direction: | Ascending R
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Field Direction
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Description A
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Test ] [ Save ] [ Save As ] [ Preview '] [ Print *] [ Close

To Specify the Sort Direction of a Field:

a. Select a Field from the table by clicking the row within the table. Information on
the selected field will display on the top portion of the screen.

b. Select a Sort Direction from the drop-down list.

c. Click the Modify Direction in List button. The table will reflect the updated
information.
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Note:

By selecting multiple rows, users can modify more than one field at a time. Only the first
row selected will appear in the top portion of the screen. However, all selected rows will
be modified in the table.

f. Repeat steps a-C as necessary.

g. (Optional) Click the Save button to save your work on the report.

4.4.7 The Group Tab (Report Designer)

The Group Tab allows users to specify the fields that will be used to group the data
included in the report output. To specify a set of grouping fields for the report, the user
will move the desired fields from the Available Column to the Selected Column. The
resulting data for the report will be grouped using the fields in the order that they appear
in the Selected Column.

Figure 36:  Report Designer - Group Tab

Report Designer - Members Due in by NRA ||
Report Data Layout Charting XML Preview
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Available Actions Selected
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Description
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Test ] [ Save ] [ Save As ] [ Preview Y] [ Print Y] [ Close
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To Group Fields:

a. Identify field(s) from the Available list that you would like the data grouped by
on your report. Select the field(s) by clicking on the checkbox next to the field
name. Once selected, a checkmark will appear in the box.

b. Click the right arrow (->) button to move the field (or fields) from the Available
list to the Selected list. Repeat this step as necessary until all desired fields appear
on the Selected list.

c. The report will be grouped using the fields in the order that they appear in the
Selected list. Change the order of this list by clicking on a field name and
clicking the Up or Down buttons. After selecting a field name, you can move it
to the top or bottom of the list by clicking the Top or Bottom buttons.

d. (Optional) Click the Save button to save your work on the report.

4.4.8 The Group Filter Tab (Report Designer)

The Group Filter Tab allows users to specify the condition to filter the data set groups
when grouping the data for use in the report. This tab functions similarly to the Filter tab;
however, the fields available for the group filter must appear in the Selected Fields list on
the Group tab. The group filter condition created is a Boolean expression used to limit
that data available in the data set for the report. To create the group filter condition, the
user must assemble filter clauses that are in the form of Field Operator Value (i.e. Field =
100). Multiple group filter clauses can be assembled to create a complex group filter
condition using logical conjunctions (i.e. And and Or) and parenthesis for grouping the
clauses into valid Boolean expressions.
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Figure 37:  Report Designer - Group Filter Tab
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To Add a Group Filter Condition:
a. Select a Table and Operator from the drop-down lists.
b. Type in the Value for the condition.
c. Select the appropriate Field for the condition.

d. If this condition will be associated with another, select a Conjunction from the
drop-down list.

e. To create complex conditions, use the Prefix and Suffix fields as necessary.
f. Click the Add Filter Condition to List button.

g. (Optional) Click the Save button to save your work on the report.
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To Modify a Filter Condition:

a. Select the row in the grid that you would like to modify by either single clicking
in that row or placing a check in the checkbox for the corresponding row.

b. The data for the selected row will appear in the fields above the grid. Make
necessary changes to fields.

c. Click the Modify Filter Condition in List button. Your changes will be reflected
in the grid.

To Remove a Filter Condition:

a. Select the row(s) in the grid that you would like to remove by either single
clicking in that row or placing a check in the checkbox(s) for the corresponding
row(s).

b. Click the Remove Filter Condition from List button. The selected tables will be
removed from the grid.

4.4.9 The Summary Tab (Report Designer)

The Summary Tab allows users to specify the fields that will be used to summarize the
data included in the report output. To specify a set of summary fields for the report, the
user will move the desired fields from the Available Column to the Selected Column.
The resulting data for the report will display the Sum of numeric fields and the Count of
non-numeric fields in the order that the fields appear in the Selected Column.
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Figure 38:  Report Designer - Summary Tab
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To Summarize Fields:

a. Identify field(s) from the Available list that you would like to use to summarize
the data on your report. Select the field(s) by clicking on the checkbox next to the
field name. Once selected, a checkmark will appear in the box.

b. Click the right arrow (->) button to move the field (or fields) from the Available
list to the Selected list. Repeat this step as necessary until all desired fields appear
on the Selected list.

c. The report will be summarized using the fields in the order that they appear in the
Selected list. Change the order of this list by clicking on a field name and
clicking the Up or Down buttons. After selecting a field name, you can move it
to the top or bottom of the list by clicking the Top or Bottom buttons.

d. (Optional) Click the Save button to save your work on the report.
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4.4.10 The Format Tab (Report Designer)

The Format Tab is an optional feature that allows users to specify the width and format of
the fields or columns that will appear in the report. Users can choose to specify the
width, the format or both the width and format of the columns.

Figure 39:  Report Designer - Format Tab
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[ Test ] [ Save ] [ Save As ] [ Preview *] [ Print *] [ Close

To Modify a Field’s Format:

a. Select a Field from the table by clicking the row within the table. Information on
the selected field will display on the top portion of the screen.

b. Type in the desired column Width (in number of characters). Note: The entered
value must be less than the default field width; entering a value greater than or
equal to the default field width will not change your report.

c. Type the Format for the field. Note: This field must conform to what the
String.Format() method expects in the .NET framework. Please refer to Appendix
A
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d. Click the Modify Format to List button. The table will reflect the updated
information.

e. Repeat steps a-d as necessary. Note: If the Width value remains zero, the report
will display all data for the specified field.

f. (Optional) Click the Save button to save your work on the report.

4.4.11 The Expression Tab (Report Designer)

The Expression Tab allows users to create an expression that will be available in the
report data set as a calculated field. The expression must be a valid SQL expression to
appear in the report data set.

Figure 40:  Report Designer - Expression Tab
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Report Data
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Expression
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servicemember. fullname+"+ServiceMember. SSN

Test ] [ Save ] [ Save As ] [ Preview Y] [ Print Y] [ Close

To Add an Expression:

a. Type in a Name for the expression. Note: Spaces and special characters should
not be used in this field.

b. Type in the desired Expression.

NMCMPS
2010.12.15

49 UNCLASSIFIED



c. Click the Add Expression to List button.
d. (Optional) Click the Save button to save your work on the report.
To Modify an Expression:

a. Select the row in the grid that you would like to modify by either single clicking
in that row or placing a check in the checkbox for the corresponding row.

b. The data for the selected row will appear in the fields above the grid. Make
necessary changes to fields.

c. Click the Modify Expression in List button. Your changes will be reflected in
the grid.

To Remove an Expression:
a. Select the row(s) in the grid that you would like to remove by either single
clicking in that row or placing a check in the checkbox(s) for the corresponding

row(s).

b. Click the Remove Expression from List button. The selected expression will be
removed from the grid.

4.4.12 The Position Tab (Report Designer)

The Position Tab allows users to specify the order that the fields and/or expressions will
appear in the report.
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Figure 41:  Report Designer - Position Tab
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To Position Fields and/or Expressions in a Report:

a. Click in the row of the first field or expression that you would like to appear in
your report. The Position value will change from “0” to “1”, indicating that this
field will appear first in your report.

b. Click the row of the second field or expression that you would like to appear in
your report. The Position value will change from “0” to “2”.

c. Repeat as necessary or until all Position values are changed from “0”. Note: If a
Position value remains as “0”, it will appear before all other values. If multiple
Position values remain as “0”, they will appear before all other values in the order
they are listed in the table(s).

d. (Optional) Click the Save button to save your work on the report.

Note:
To remove a Position value from a row or to return the value to “0”, click in the row for a
second time.
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For best results, Positions should be removed in reverse order. For example, if your list
is numbered 1-10 and you need to renumber item number 6, start with changing the “10”
value to “0” and proceed backwards until you reach item number “6”.

4.4.13 The SQL Tab (Report Designer)

The SQL Tab allows users to review the SQL statement created by the Report Designer.
This tab displays read-only information. Users can copy and paste the SQL statements
out of the Report Designer.

Figure 42:  Report Designer - SQL Tab
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select Lookup_All UICs.CLAIMANT,Lookup_All_UICs.Description,Lookup_All_UICs.LACMOB, Lookup_Al UICs.Site,substring
(ServiceMember.55N.6.4) as Test1,servicemember.fullname+"+ServiceMember.SSN as Test2

from Lookup_All_UICs

where [ ServiceMermber.NRA_UICCode = 'SNULL' and

ServiceMember.BiletCode 1= "SE' )

order by Lookup_All UICs.CLAIMANT asc,Lookup_All UICs.Description asc,Lookup_All UICs.LACMOB asc

B T e et e e i
B e e e e e e

Test ] [ Save ] ’ Save As ] [ Preview "] ’ Print "] [ Close

45 THE LAYOUT TAB (REPORT DESIGNER)

The Layout tab is used to design the layout or output format of the report. By arranging
fields and/or adding text, users can change the title, header, detail, footer, and summary
of the report. This tab is optional; if the user does not specify a report layout, the report
data will be output in a standard list format.
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Figure 43:  Report Designer - Layout Tab
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To Modify the Layout of a Report:

a. Select the section that you would like to modify by clicking the associated
icon until the band expands and the associated

+

icon changes to a

+

b. To add text to the selected section, select the Text Widget. The field picklist will
become disabled and the edit control will become available. Type the text into
the edit control field that becomes available. Click the Add to Layout button.
The text will become available on the canvas section of the selected band.

c. To add a field value to the selected section, select the Field Widget. Select the
desired field from the available drop-down list. Click the Add to Layout button.
The field will become available on the canvas section of the selected band.

Note:

The Field Widget is not available on the Title band.

The Detail ban will only display fields previously selected on the Fields tab.

The Summary band will only display fields previously selected on the Summary tab.
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The Header and Footer band will only display fields previously selected on the Group
tab.

d. To resize or rearrange the text or fields displayed on the canvas, use your mouse
to drag and drop the text into a new location or resize the text.

e. To remove text or fields displayed on the canvas, double click on the text so that
it changes color. Once highlighted, click the Remove From Layout button.

f. (Optional) Click the Save button to save your work on the report.

46 THE CHARTING TAB (REPORT DESIGNER)

The Charting tab allows users to chart or graph the data from their report. The Charting

tab itself contains two tabs for defining the chart style, data series, fields and labels used
in the charts.

Users will first use the Charts tab to name their charts and decide on a style. Next, they
will use the Chart Series tab to select the fields, field labels and series labels for the
charts. If “Chart/Graph (HTML)” was selected as the default output on the Reports tab,
users can preview their charts using the Preview tab. Otherwise, to view their charts,
users can select “Chart/Graph (HTML)” from either the Preview button or Print buttons.
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Figure 44:  Report Designer with Chart Displayed
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4.6.1 The Charts Tab (Report Designer)

The Charts Tab allows users to provide a Name for the charts they would like to select.
and select the chart style. The following image displays the Charts Tab.
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Figure 45:  Report Designer - Charts Tab
Report Designer - Working Group Demo Report Three D
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To Add a Chart:

a. Type in a Name for the Chart.

b. Select the desired chart Type from the drop-down.

c. Click the Add Chart To List button.

d. (Optional) Click the Save button to save your work on the report.
To Modify a Chart:

a. Select the row in the grid that you would like to modify by either single clicking
in that row or placing a check in the checkbox for the corresponding row.

b. The data for the selected row will appear in the fields above the grid. Make
necessary changes to fields.

c. Click the Modify Chart In List button. Your changes will be reflected in the
grid.
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To Remove a Chart:

a. Select the row(s) in the grid that you would like to remove by either single
clicking in that row or placing a check in the checkbox(s) for the corresponding
row(s).

b. Click the Remove Chart From List button. The selected chart will be removed
from the grid.

4.6.2 The Chart Series Tab (Report Designer)

The Chart Series Tab allows users to create a Series Name for the charts and select a
value field and a label field. The following image displays the Chart Series Tab.

Figure 46:  Report Designer — Chart Series Tab
Report Designer - Working Group Demo Report Three -|l?|x
Report Data Layout Charting XML Preview
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To Add a Series:

a. Select the Chart you would like to modify from the drop-down.
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g.

Type in a data series Name for the chart. Note: This name will display in the
legend to identify the charted data.

Select the type of information you would like to graph by selecting a VValue Field
from the drop-down.

(Optional) To label the graph, select a Label Field from the drop-down.
If necessary, modify the chart Type.
Click the Add Series To List button.

(Optional) Click the Save button to save your work on the report.

To Modify a Series:

a.

Select the row in the grid that you would like to modify by either single clicking
in that row or placing a check in the checkbox for the corresponding row.

The data for the selected row will appear in the fields above the grid. Make
necessary changes to fields.

Click the Modify Series In List button. Your changes will be reflected in the
grid.

To Remove an Expression:

a.

Select the row(s) in the grid that you would like to remove by either single
clicking in that row or placing a check in the checkbox(s) for the corresponding
row(s).

Click the Remove Series From List button. The selected series will be removed
from the grid.

4.7 THE XML TAB (REPORT DESIGNER)

The XML Tab allows users to review the XML statement created by the Report Designer.
This tab displays read-only information. Users can copy and paste the XML statements
out of the Report Designer.
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Figure 47:  Report Designer - XML Tab
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[ Test ] ’ Save ] ’ Save As ] [ Preview "] [ Print '] ’ Close

4.8 THE PREVIEW TAB (REPORT DESIGNER)

The Preview tab is used to preview the data and layout format of the designed report.
When reports are previewed, only the first 500 records appear on the report. When
selected, the Preview tab displays the report in the default output.
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Figure 48:  Report Designer - Preview Tab
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*%% For Official Use Only *** ;
CLAIMANT Description LACMORB | Site
0200 CNAVRES TRANSIENT NULL N
0200 CNEIC MGMT IVTU 0210 NULL N
0200 JAPAN TRANSIENT NULL N
0200 NAF ANDREWS TRANSIENT NULL N
0200 NAF DETROIT TRANSIENT NULL N
0200 NARTD MIRAMAR TRANSIENT NULL N
0200 NARTD MOFFETT FLD TRANSIEN NULL N
0200 NARTU ALAMEDA TRANSIENT NULL N
0200 NARTU JAX TRANSIENT NULL N
0200 NARTU L ALAMITOS TRANSIENT NULL N
0200 NARTU LAKEHURST TRANSIENT NULL N
0200 NARTU MEMPHIS TRANSIENT NULL N
0200 NARTU NORFOLK TRANSIENT NULL N
[t Tt KADTTT THATRTIT AATTAET T TD A RISTERTT ™I T I ag
[ 7est || save || saveas |[ Preview ][ Pt v][ close |

When viewing reports through the Preview tab, clicking the Close button will close the
Report Designer and will not save any changes.

Note:

To preview the report in a different output, click arrow next to the Preview button at the
bottom of the window. Select the desired output from the displayed list. A secondary
window will display a preview of the report. Click the Close button on the Report
Preview Window to close the secondary screen and return to the Report Designer.
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SECTION 5: The DRT Ad-Hoc

5.1 THE DRT AD-HOC OVERVIEW

The DRT Ad-Hoc allows nontechnical users to build Ad-Hoc reports. The DRT Ad-Hoc,
a subset of the DRT Report Builder, allows users to create and print custom reports that
pertain to the information in the selected module.

Before accessing the DRT Ad-Hoc, users can specify search criteria on any of the
following pages:
e PM Member Processing Page
AMM Member Browse Page
OWM Contact Browse Page
OWM Reports Page
SM Requirements Page
SM Sourcing Browse Page

The DRT Ad-Hoc will automatically create filters based on the selected criteria.

5.2 ACCESSING THE DRT AD-HOC

The DRT Ad-Hoc can be accessed through any page within NMCMPS that also offers
access to the NMCMPS Ad-Hoc tool. The following table lists each module and the
corresponding page that presents access to the DRT.

Table IV: NMCMPS Search Pages that Provide Access to DRT

Module Search Page
Processing Member Processing
Augmentation Management Member Browse
Order Writing Contact Browse
Reports
Sourcing Requirements
Sourcing Browse

Once you have navigated to any of these pages, access the DRT Ad-Hoc by clicking the
DRT button located above the WebGrid. When opened, the Report Builder page will
display the Fields tab. The Table field will be populated with the Ad-Hoc table for that
specific page or module.
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Figure 49: DRT Ad-Hoc Page (accessed from AMM)

Report Builder |2

Fields Sort Sort Direction Summary Format Position Report Preview
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Available Actions Selected
Field = 7 Field
AMKM POC - Top
AUIC Code
Approved Detach Date E
Claimant
Claimant Status
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Desig/Rating
Designator
Dest. UIC
Detach Date
G Code
Group
Hold Type
(]

Last Updated
NEC
MMPS EDA
NMPS UIC
NOBC il
[ Test ] [ Save ] [ Save As ] [ Preview Y] [ Print Y] [ Close

The DRT Ad-Hoc will create conditions used for filtering the data based on the criteria
you entered into the fields on the module Search pages. Although not immediately
visible from the DRT Ad-Hoc, these conditions can be viewed from the Filter tab which
is available when DRT is accessed directly from the NMCMPS Site Map.

Note:
The Report Builder’s Filter tab can also be viewed within the DRT Ad-Hoc by holding
down the “Ctrl-Shift-F” keys.

5.3 CREATING AN AD-HOC REPORT

After navigating to one of the NMCMPS search pages listed above, enter search criteria
on the top of the page as if you were going to conduct a standard WebGrid search.

By selecting the DRT button, the DRT Ad-Hoc displays eight of the nine Report Builder
tabs. Users should start with the Fields tab and work across the screen from left to right,
ending with the Preview tab.
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When you initially select a tab, you will see the tab contents in view mode. Once you
make changes or edit information, you will need to Save the changes before closing out
of the Report Builder.
To Create an Ad-Hoc Report:
a. Access a NMCMPS search page that offers DRT Ad-Hoc access. (Refer to
Accessing the DRT Ad-Hoc for a list of pages within NMCMPS that offer DRT
Ad-Hoc access.)

b. Specify the search criteria for your report in the top portion of the screen and click
the DRT button.

c. Use the Fields tab to specify the fields to be used within the report.
d. Engage the optional Sort, Summary, Format and Position tabs as desired.

e. If the report will be needed for future use, navigate to the Report tab and enter the
report identifiers so that the report can be saved.

f. Click the Save, Preview or Print button as appropriate.

Note:
A report will not save unless all required information is entered into the Report tab.

Saved reports are accessible via the DRT Report Manager, which is accessed via the
DRT link on the NMCMPS Site Map. To access a saved report from either the Report
Builder or Report Designer, navigate to the Report tab and select the Report from the
drop-down list.

54 THE FIELDS TAB (DRT AD-HOC)

The Fields Tab allows users to specify the fields that will be available for inclusion in the
report output. The Table field will be populated with the tables available from within the
module you accessed the DRT Ad-Hoc. The following image displays the Fields Tab.
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Figure 50:  DRT Ad-Hoc - Fields Tab
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To Select Fields:

a. The Table field will populate with the Ad-Hoc table from the module in
which you opened the DRT Ad-Hoc.

b. From the Available list, select the fields(s) you want to include in your report
by clicking on the checkbox next to the table name. Once selected, a
checkmark will appear in the box.

c. Click the right arrow (->) button to move the field (or fields) from the
Available list to the Selected list. Repeat this step as necessary until all
desired fields appear on the Selected list.
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Figure 51:  DRT Ad-Hoc - Selected Fields
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d. When you finish selecting the fields, you can change the order of the list by
clicking on a field name and clicking the Up or Down buttons. After
selecting a field name, you can move it to the top or bottom of the list by
clicking the Top or Bottom buttons.

e. (Optional) Click the Save button to save your work on the report.

55 THE SORT TAB (DRT AD-HOC)

The Sort Tab in the DRT Ad-Hoc is the same as the Sort tab in Report Builder. Please
refer to The Sort Tab (Report Builder) section for more information on the features and
procedures associated with this tab.

56 THE SORT DIRECTION TAB (DRT AD-HOC)

The Sort Direction Tab in the DRT Ad-Hoc is the same as the Sort Direction tab in
Report Builder. Please refer to The Sort Direction Tab (Report Builder) section for more
information on the features and procedures associated with this tab.
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57 THE SUMMARY TAB (DRT AD-HOC)

The Summary Tab in the DRT Ad-Hoc is the same as the Summary tab in Report
Builder. Please refer to The Summary Tab (Report Builder) section for more information
on the features and procedures associated with this tab.

58 THE FORMAT TAB (DRT AD-HOC)

The Format Tab in the DRT Ad-Hoc is the same as the Format tab in Report Builder.
Please refer to The Format Tab (Report Builder) section for more information on the
features and procedures associated with this tab.

59 THE POSITION TAB (DRT AD-HOC)

The Position Tab in the DRT Ad-Hoc is the same as the Position tab in Report Builder.
Please refer to The Position Tab (Report Builder) section for more information on the
features and procedures associated with this tab.

5.10 THE REPORT TAB (DRT AD-HOC)

The Report Tab in the DRT Ad-Hoc is the same as the Report tab in Report Builder.
Please refer to The Report Tab (Report Builder) section for more information on the
features and procedures associated with this tab.

5.11 THE PREVIEW TAB (REPORT BUILDER)

The Preview Tab in the DRT Ad-Hoc is the same as the Preview tab in Report Builder.
Please refer to The Preview Tab (Report Builder) section for more information on the
features and procedures associated with this tab.
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Appendix A: .NET Standards

Specifier

Horm

Yoory

Any otner single
character

Mame
Short date patben
Long date pattern

Full date/time pattern
{shaort time)

Full date/time pattesn
{long time)

Gzneral datz/tima
pattemn (short time)

General dats/time
pattermn (long time)

Month day pattern
Round-oip date/tme
cattem

RFC1123 patem
Sortable date/time
oathen; 150 8601

Short dme patbem

Long time pattem

Universal sortable
datetime patham

Universal sortable
date/dme patem

‘fear month pathem

(Unknown specifier]

a ..
Represents a custom DateTime format sting defined by the current ShortDatePattesn property.
Represents a custom DateTime format soing defined by the current LongDatePattern property.

Represents a combination of the long date (DY) and short dme (t) patterns, separsted by 2 space.

Represents a customn DateTime format sting defined by the current FullDateTimePattern property,

Reprasents a combination of the short date (d) and short Sme () pattens, ssparated by 2 space.

Represents a combination of the short date (d) and long tme (T) pattemns, separated by a space.

Represents a custom DateTime format soing defined by the current MonthDayPattem property,

Represents a custom DateTime format soing using a patiem that preserves time zone information, The pattem is designed to round-trip DateTime

formats, including the Kind property, in text. Then the formatted string can be parsed back using Parsz or ParseExact with the comect Kind crooery
vahsz. Equivalent custom format string is Myeyy'- MM-dd T'HH''mim' s FFAFK",

Represents a custom DateTime format soing defined by the current RFC1123Pattern prooerty, The patteen is a defined standard and the property is read-

only. Equivalent custom format string is "ddd, dd MMM wyyy HH':'mm':'ss 'GMT", Does niot convert DateTimes o UTC.

Reprasents a custom DateTime format string defined by the current SortableDateTimePattern property.
This pattem is a defined standard and the property is read-only, Equivalent custom format string is “pyyy'=MMdd THH Y 'mm's'ss".

Represents a customn DateTime format sting defined by the current ShortTimePattern property,
For examzle, the custom format string for the invariant cufters s "HH:mm™

Represents a customn DateTime format sting defined by the current LongTimePattern property.
For examole, the custom format string for the invariant oufturs s "HH:mmiss".

Represents a customn DateTime formnat sting defined by the current UniversalSortableDateTimePattem property,
Eguivalent custom format string is “yypy'-MM'-dd HH''mm's's='2", Does not conwvert DeteTimes to UTC.

Represents a custom DateTime format sting defined by the current FullDateTimePatterm property, This pattern is the same as the full date/long time (F)
pattern. However, formatting operates on the Coordinated Universal Time [UTC) that is equivalent to the DateTime object being formatted.

Represents a custom DateTime format soing defined by the current YearMonthPattern property.
For examgle, the customn format string for the invariant culure is "yyyy MMMM',

An unknown specfier throws 2 runtime format exception,
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Specifier

£

FE..

BOT EE

kik

HH

Description

Repressnts the day of the month a5 a number from 1 thwough 31, A single-digit day is formatted without a leading zemo,

Represents the day of the month &5 a number from 01 twowgh 31. A single-digit day is formatted with & leading zem.

Regresents the abbreviated name of the day of the week as defned in the current System,Globalization, DateTimeFormatinfo. AbbreviatedDayiames property,
Represents the full name of the day of the week as defined in the current System.Globalization. DateTimeFormatinfo.DayMames property,

Reoresants the most significart dgit of the seconds fraction.

Mate that if the "f" format soecifier is used alone, without othes format specifiers, it is interpreted as the "f" standard DateTime format specifier (full date/time pattem).

‘When you use tis format scecfier with the ParseExact or TryParseExact method, the number of " format specifiers that vou use indicates the numzer of most significant digits of the
saconds fraction to parse.

Mumber of repeated specifiers represents most signficant digits of the secends fraction.

Represents the most significant digit of the s=conds fraction. Mothing &= displaved if the digit is zaro.

‘When you use tvs format scecfier with the ParseExact or TryParseExact method, the number of "F" format specifiers that vou use indicates the maximum number of most sionificant
digits of the seconds fraction to parse.

Murmiber of repaated specifiers represents mest significant digits of the saconds fraction, Traling zeros, or two zaro digits, are not displayed,

Represents the pericd or ara (AD. for exampla). This specifier is ignored if the date to be formatted doss not have an associated period or era string.

Represents the howr as a number from 1 through 12, that is, the hour as reoresented by & 12-hour clock that counts the whiole hours since madnight or noon.
& single-digt hour is formated without a leading zere.

Represants the hour as & number from 01 through 12, that is, the hour a5 recresented by 2 12-hour clock that counts the whole hours since midnight or noan.
A single-digit hour is formatted with a leading zero.

Represants the howr as a number from 0 through 23, that is, the hour as reoresented by a zemo-basaed 24-hour clock that counts the hours since midnight.
& single-digt hour is formated without a leading zere.

Represants the hour as & number from 00 through 23, that is, the hour a5 regresented by 2 zero-based 24-hour cleck that counts the hows since midnight.
A single-digit hour is formatted with a leading zero.

Represents different values of the DateTime.Kind property, that is, Local, Ute, or Unspecified. This specifier round-trips the kind value in test and preserves the time zone, For the Locz!
kind walug, this specifier is equivalent to the "zzz" spedifier and displays the local offset, for example, "-07:00", For the Utc kind value, the specfier displays a "Z" character to represant
a UTC date, For the Unspedified kind value, the specifier is equivalent to ™ {nathing).

Represents the minute as a number from 0 through 59. The minute recresents whole minutes passed since the last hour,
& single-digit minute s formeted without a leading zaro.

Represents the minute as a number from 00 through 59. The minute represents whole minutes passed since the last haur,
A single-digit minute is formatted with a leading zero.

Regresents the month 25 a numzer from 1 theowgh 12, A single-digit month is formatted without a leading zero.

Regresents the month 25 a numzer from 01 through 12, A single-digit month is formatted with a leading zere.

Regresents the abbreviated name of the month as defined in the current System.Globalization. DateTimeFormatInfoActrevistedMonthames progerty.
Reoresants the full name of the manth as defined in the current System.Globalization, DateTimeFormatinfo,MonthNames procarty.
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25

tt

¥y

¥¥¥

YYYY

YYYYY

X

Irr

Xe

e

Amy oTner char,

Represents the seconds as a number from 0 through 55, The second represents whoke seconds passed since the last minute.
A single-digit second is formatted without 2 keading zevo.

Represents the seconds as a number from 00 through 53, The second represants whaole seconds passed since the last minute.
A single-digit second is formatted with a leading zero.

Represents the first characwer of the AML/P.M, designator defined in the current System.Globalization. DaeTimeFormatinfo.AMDesignator or
Systzm . Globalization.DateTimeFormatinfo PMDesignator prassrty.

Represents the AM./P.M. designator as defined in the current System, Globalization DateTimeFormatInfo. AMDesignatar or
SystzmGlotalization.Det=TimeFormatinfo. PMDesignator prossity.

Riepressnts the vesr as at most a two-digit number, IF the vear has more than two digts, only the two low-onder digits appear in the result,
If the year has fewer than two digits, the number is formatted without 2 l=ading zewo,

Regresents the year as a two-digt number, If the year has more than two digits, only the two low-order digits appear in the result.
If the year has fewer than two digits, the number is padded with l=ading zeroes to achisve two digits.

Riepressnts the year as a thres-digt number. If the year has more than thres digits, only the thres low-order digits aposar in the result. IF the year has fewer than three digits. the
number is padded with leading zeroes to achisve three digits, Mote that for the Thai Buddhist calendar, which can have five-dig years, this format specifier disglays 2l five digits.

Regresents the year as a four-digit numzer, IF the year has more than four digits, only the four low-order digits appear in the result. If the year has fewer than four digits, the numbes
iz padded with leading zerces to achieve four digits, Mote that for the Thai Buddhist calendar, which can have five-digit years, this format specifier renders all five digits,

Regresents the year as a five-digit numzsr, If the year has more than five digits, enly the five low-order digits appear in the result, If the yaar has fewer than five digits, the numaer is
padded with leading zeroes to achieve five digits. If there are additional "y" specifiers, the number is padded with as many keading zeroes as necessary to achieve the number of *y"
specifiers.

Represents the signed time zone offsat of your system from Greenwich Mean Time (GMT) measured in hours, For example, the offszt for 2 computer in the Pacific Standard Time zone
iz "-B8", The offset is always disclayed with 2 leading sign, A plus sign (+) indicates hours ahead of GMT and & minus sign {-) indicates hours behind GMT. The offset ranges from -12
through +13, & single-digt offset is formatied without a leading zero. The offzet is affected by davlight savings time.

Reoresents the sianed time zone offsat of vour system from Gresnwich Mean Time (GMT] measured in hours, For example, the offset for  computer in the Pacific Standard Time zone
iz "-08", The offsat is zhvays displayed with a leading sign. A plus sign (+) indicates hours zhead of GMT and 2 minus sign {-) indicates howrs behind GMT, The offset ranges from -12
through +13, A single-digit offset is farmamed with a leading zero. The offsat is affected by daylight savings tims.

Regresents the signed tme zone offsat of vour system from Greenwich Mean Time (GMT) measurad in hours and minutes, For example, the offset for a computer in the Pacific
Standard Time zone is "-08:00", The offset is always displaved with a keading sign. A phes sign (+) indicates hours ahead of GMT and a minus sian (-} indicates hours bzhind GMT. Tha
offset ranges from -12 through +13. A single-digit ofset is formatted with a leading zero. The offset is affected by daylight savings tme.

The time separator defined in the current System.Globalzation.DateTimeFormatInfo. TimeSeparatar property that is used to diffesentate hours, minutes, and seconds,
The date separator defined in the current System.Globalbzation.DateTimeFarmatInfo. DateSeparator property that is used o differentiate years, months, and days.

Quated string (quotation mark). Displays the literal valus of any string between two quotation marks ("), Precede sach quotation mark with an escape character (V)

Quoted string (apostrophe). Displays the litera] value of any string between two apostrophe (') characters,

LT
@

Represents the resul associated with a custom format specifier ", when the custom DateTime format string consists solely of that custom format specifiar. That is, to use the '
"FORT Tt e M Y M "R, or "M custom formiat specifier by itsalf, soecify "9ed”, "9, "9F", "Sh”, "aem”, "oes”, "ar”, "ouy", vz, "M, or %M,

v

The escape character. Displays the character "c" as a breral when that character is preceded by the escape character (1)
Ta insert the backslash charactzr itlf in the result string, use twio escape characters [,

Any other character is copied to the result string, and does rot affect formatting,
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Specifier Name Description

Core Currency The rumber is convertad to 2 soing that represents a curency amount. The conversion is controlled by the currency format information of the current
MurrserFormatinfo chject, Pracision specifier [eg. "{0:C5)" allowed.
o oord Decimal This format is supported only for integral types, The number is converted to 2 string of decimal digits [0-3), prefized by a minus sign i the number is negative, Precision
specifier (eg, "{:d3}" allowed.
E ar e Scientific The rumber is convertad to 2 soing of the form "-dddd.. E+ddd” o "-d.ddd...2=ddd", wherz each 'd indicates a digit (0-5). The s¥ing starts with 2 minus sign i the
{exponental) numzsr is negative, One digit always precedss the decimal point,

Precision specifier (eg, "{0:ES}" allvwed. The case of the format specifier indicates whether to prefix the exponent with 2n 'E or an ‘e, The exponent always consists of
a phus or minus sign and a mivimum of three digits, The exponent is padded with zeros to meet this minimum, i© required.

F ar f Fixed-paint The rnumber is convertad to 2 stoing of the form “-ddd.ddd_." where sach ¢ indicates 2 digit (0-9). The string starts with a minus sign if the number is negative.
Precision specifier (eg, "{0:f4}" allowed,

Gorg Geneal The rumber is convertad to the most compact of either fixed-point or scentific notation, decending on the type of the number and whether 2 precision specifier is
prasent,

Naorn Murmbsr The number is convertad to 2 string of the form "-d,ddd,ddd.ddd..", where -’ indicates 2 negative number symbal if required, 'd' indicates a digit (0-9), ', indicates &

thousznd separstor between number groups; and ' indicates & decimal point symbel. The actual negztive number pattern, number grous size, thousand separztor, and
decimal separator are specified by the current MumbesFormatinfo object. Precision specifier (eg. "{0:N5}" allowed,

Poorp Percent The number is convertad to 2 string that represents a percent as defined by the MumbesFormatinfo,PercentiegativePattern property if the number is neqative, or the
MumbstFormatInfo.PercentPositivelatbern property if the mumber is positive. The converted numbes is multiplied by 100 in order 1o be presented as 3 percentags.
Pracision specifier {eg, "{0:pe)" allvwed.

R or Rownd-trip This format is supported onby for the Single and Double tyoes. The round-trip specifier quarantees that a numeric value converted to a string will be parsed back into the
same numaric vahee. When a numesic value is formatied using this specifier, it is first tested using the general formar, with 15 spaces of precision for 2 Double and 7
spaces of precision for 2 Single. If the value is successfully parsed back to the same numeric vakus, it is formatted using the general formiat specifier. However, if the
value is not successhully persed back wo the same numeric value, then the value s formatted using 17 digits of precision for 2 Double 2nd 3 digits of precision for a
Single. Pracision specifier NOT allowsd,

X oor x Hexadecimal This format is supported only for integral types, The number is converted to 2 string of hexadecimal digits. The case of the format specifier indicates whether to use
uppercase or lowerncase characters for the hexadecima! digit greates than 5. Precision specifier (g, "{0ued}” allowed. If required, the number is padded with zeros wits
left to preduce the number of digits given by the precision specifier.

Arvy other {Unknown An unknown specifier throws a runtime format exception.
single char,  specifier]

Examples (en-US)

Formsat String  Data type Walue Dutput Format String  Daka type Value Cutput Format String  Data bype Value Output

C Diotibie LIMEETES 413,568 r Dociihike IZMEETED | LZ35.68 =] Doable 1234 LIE3

o Int3z 12345 13345 ra Doubike IZMEETED | 1ZI56 § Dbl Math. Pl 3. MI30TESTIRTY
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Specifier Name

a

E@
E-8
E-B
L]
e=f
e-a

“ABC'
“ABC"

Other

Zero placsholder

Digit placsholder

Diecimal point

Thousand seoarator

and rumber scaling

Percentage
placeholder

Scientific rotation

Escape character

Lizeral string

Section separator

All other characters

Description
If the vahue being foematted has 2 digit in the position where the 0" appears in the foemat string, then that digit is copied to the result string, The position of the
leftmost "0 before the decimal point and the rightrmost "0 after the decimal point determines the range of digits that are always present in the result string,

The "00" specifier causes the value to be rounded to the nearest digit preceding the decimal, where rounding away from zer is abways used. For examole, formatting
34,5 with "00" weuld result in the value 35,

If the value being formatted has & digit in the position where the "#' aoosars in the format siring, then that digit is copied to the result string. Otherwise, nothing is
stored i that position = the result string. This specifier never disolays the ') character if it is not 2 significant digit, even iF '0" is the only digit in the sting, Tt will
display the 0’ character if it is a significant &g in the number being displayved, The "£#" format string causes the valus to be roundad to the nearest dig't pracading
the decimal, where rounding away from zero is ahways used. For example, formatting 34.5 with "##”" would result in the value 35,

The first "' character in the format soing determings the location of the decimal ssparator in the formatted value; any additionsl "' characters arz ignored. The actual
character usad as the decimiz! szparstor is determined by the NumberDecimalSeparator property of the NumserFormztinfs that controls formatting.

Thousand Separator Specifier

If ane or more ' charactess is specified between two digit placeholders (0 or #) that format the integral digits of a number, & group separator character s inssrmed
between sach numbsr groups in the integral part of the output. The NumberGroupSeparator and NumterGoupSizes properties of the current NumzerFormatInfo object
detarmine the character used as the number group separator and the sz2 of sach number groun,

Mumber Scaling Specifier

If one or more ' characters is soecfied immediately to the left of the exolicit or implicit decimal point, the number to be formatted is dvided by 1000 sach tims 2
numzer scaling specifier cocurs. For example, if the sting "0,," is used to format the number 100 million, the output is 100", You can use thousand separator and
number scaling specifiers in the same format string.

The presence of a "%’ charactzr in a format string causes a numt=sr to be multiplied oy 200 before it is formatizd. The approgriate symbol is inserted in the number
itselt at the location where the %" appears in the format string. The percent character used is dependent on the cunent NumbsrFormatnfo class,

If @y of the stiings "E", "E+", "E-", "e", "&+", or "=-" are prasent in the format swing and are followed immediately by at l2ast one '0' charactzr, then the number s
formatted using scentific notation with an 'E' or &' inserted betwesn the number and the exponent, The number of '0' characters following the scientific notation
indicator determines the minimum number of digits to cutput for the exsonent. The "E+" and "a+" formats indicate that 2 sign character (plus or minus) should always

precede the exponent, The "E", "E-", "&", or "e-" formizts indicate that a sign character should only preceds negative exponents.

In C# and C++, the backslash character causes the nest character in the format string to be interpreted 2s an escape sequence, It is used with traditional formatting
sequences like "n' (new line). In some languages, the escape character itself must be preceded by an escaoe character when used as a [teral. Otherwise, the compiler
interprets the character 25 an escape sequence, Use the string "\\" to display . Mote that this escape character is not supported in Visual Basic; however, ControlChars
provides the zame functionality,

Characters enclosed in single or doutle quotes are copied o the result string, and do not affect formatting,

The "' character is usad to separate sactions for positive, negative, and zers numEsrs in the format string.

Any other character is copisd to the result string, and doss not affect formeating.
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Section Separators and Conditional Formatting

Different formatting can be apoied to a string based on whether the value is positive, negativa,
or 2ero, To produce this behavior, a custom format string can contain up to thees sections
separated by semicolons, These sections are described in the following table,

Custom Numeric Format Strings Output Examples

The following table illustrates the outout oeated by applying some custom numeric format
strings to specific data types and values, The output was generated using the ToString methad
and the Englizh-United Stztzs (en-US) culturs,

UNCLASSIFIED

No. of Sections Description Format string Datatype  Value Dutput
One saction The format string applies o all values. N Dauble 171 173
Twao sections The first section applies to positive values and zeros, and the second BEEEE Doubla 173 00123
section apobes to negative values,
_ i (MERY RER - pUER Double 1234567850 [123) 456 — 7830
If the number to be farmenzd is negatve, but becomes zero after
rounding according to the format in the second section, then e LR Double 1.2 1.2
resulting zero is formatted according to the first section,
a.aa Double 1.2 1.20
Three sections The first section applies to positive values, the second section applies o
negative values, and the third ssction applies o zers. B8 . B8 Double 1.2 01.20
The second section can be left empty (by having nothing between the L Double 1234557930 1,434,567,890
semicolons], in which case the first section aooles to all nonzens valuss. - Double 1734557890 1738
If the number to be formated is nonzero, but becomes zero after
- ' BER
rounding according to the format in e first or second section, then the Double 1234357850 !
resulting zero is formatted according to the third section, , Rea, Dauble 1234557890 1335
Section ssparatars ignare any oreexisting formatting 2ssociated with a number when the final . ATS Double 0.088 B.58%
value is formatted, For example, negative values are always displayed without a minus sign
whien saction separators are used, If you want the final formatted vakee to have a minus sign, 8. KkREsD Double 5000 B.EE+4
you should explicithy inchude the minus sign as part of the custom formet soedfier., O . BRRE+00 Doubla 86000 BLEE+004
. NERE-000 Couble BE000 E.5E004
[ - w2 ] Double 123455 [12-34-58]
TR Double 1234 1234
W () Double 1234 (1234)
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Appendix B: DRT Tool Flow

The following diagram provides an overview of the Dynamic Reporting Tool.
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